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About Spark
Spark suggests biologically relevant replacements (bioisosteres) for key fragments of known active
molecules. You load an active molecule into Spark, preferably in the bioactive conformation, circle the part
of the active that you wish to replace and specify which databases to search. Spark will present a list of
biologically relevant replacements ranked using Cresset’s unique molecular field technology
(http://www.cresset-group.com/science/). As well as replacing central parts of a molecule, Spark can suggest
replacements for terminal groups. It can be used to grow ligands and fragments into unoccupied pockets of
the target protein, carry out ligand joining and macrocyclization experiment, and to find a fragment which
displaces a crystallographic water molecule near your ligand.
To create the results, Spark uses a set of databases that contain conformationally explored fragments. These
databases are stored on a file system that must be accessible to the main application. Usually this means the
local disk but can be network disks or removable drives as well.

Supplied Binaries
Spark functionality is available through a graphical user interface with two interlinked binaries (Spark,
FieldEngine) and as command line binaries (sparkcl, sparkdb, sparkdbupdate and FieldEngine):
Spark.exe

The main graphical interface for Spark.

FieldEngine.exe

The calculation engine for Spark and command line binaries. FieldEngine is started
directly by the primary interface to perform specific calculation tasks. By default,
one FieldEngine binary is started for each CPU core on the host machine (but this
can be reconfigured in the application preferences or by command line switches).
The applications communicate with the FieldEngine using a TCP/IP protocol that
can cause network access warnings in some situations.
The FieldEngine process can be run on a remote machine with communication
managed through a variety of methods including Cresset’s Engine Broker.

sparkcl.exe

This is the command-line equivalent to the main Spark GUI. It is used to search a
database of fragments for bioisosteres of the section of the molecule that you
specify on the command line. At the completion of the calculation the ‘sparkcl’
application collates the results and outputs these in the format specified by
command line options (e.g. SDF file).

sparkdb.exe

This is the command-line version of the database generator functionality in Spark.
It is used to create a database of fragments for use with Spark by fragmenting
existing molecules or by importing existing fragments. At regular intervals during
the calculation the ‘sparkdb’ application collates the results and saves these to the
specified database.

sparkdbupdate.exe

This binary can be used to install and update all or selected Spark fragment
databases, as an alternative to the Spark Database Updater available within the
Spark GUI.
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Supported Platforms
Minimum specifications
Hardware

Specifications

RAM

1GB

Processor

Intel i5 processor or equivalent

Disk space

6GB (for 4 Common DBs)

When using a machine close to these specifications, then Cresset recommend that only three databases are
installed and searched - contact Cresset support for a detailed discussion.

Recommended specifications
Hardware

Specifications

RAM

2GB

Processor

Intel i5 processor or equivalent

Disk space

40GB

Supported Operating Systems
Spark is supplied as 64bit binaries for Windows®, macOS® and Linux®.
Windows®

macOS®

Linux®

Windows 7

macOS 10.12

Red Hat Enterprise Linux 6.10+
CentOS 6.10+

Windows 10

macOS 10.13

Red Hat Enterprise Linux 7

Installation
Platform based installation instructions are given below and at http://cresset-group.com/installing-desktopapplications.

Installing the Spark application
Windows
1. Browse to the Windows folder of the Spark distribution media (or locate the installer in your
Downloads folder) and double click the executable installer file.
2. Follow the on-screen instructions.
3. If you have a previous version of Spark installed, then this will be removed before installing the new
version.
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Linux
1. Browse to the Linux folder of the Spark distribution media.
2. Install the Spark re-locatable rpm package using one of the command lines below (where <vers> is
the version number, <arch> is the architecture and <path> is install location (/opt by default)):
yum install cresset-spark-<vers>-1.<arch>.rpm
or
rpm -U [--prefix <path>] cresset-spark-<vers>-1.<arch>.rpm
3. Alternatively, unpack the supplied tgz file to a suitable location (e.g. $HOME or /usr/local or
/opt).
macOS
1. Open the supplied disc image.
2. Drag the Spark icon onto the Applications icon to install the application in the Applications folder.

Installing Spark Databases
The database files contain conformationally explored fragments of known molecules. Cresset recommend
installing at least the databases ‘ChEMBL_common’, ‘VeryCommon’, ‘Common’ and ‘LessCommon’ as these
cover most fragments that are convenient to synthesise.
Spark fragment databases can be installed as follows:
•
•
•

By copying to the appropriate folder (see the default database locations table below).
Using the built-in Spark Database Updater
Using the sparkdbupdate.exe binary

If you have been supplied with the databases on a USB key then simply copy them to one of the default
database locations listed below. Note that administrator privileges will be required to copy them to a system
location.
Full installation details are available at http://www.cresset-group.com/products/installing-desktopapplications.
Spark Database Updater
The Spark Database Updater (available from the Spark GUI) can be used to download and/or install and
update databases from the internet. The updater will install or update system-wide databases if the user has
permission to write to these locations, otherwise it will write to a user location or a custom location set in
the Spark Preferences (Edit → Preferences menu). Please refer to the ‘Database Updater’ section of the Spark
manual for a detailed explanation. To update system-wide databases either run the application as an
administrator and set the database download location in the Preferences, or download the databases to a
user directory then move them to the system location.
Default database locations for Spark
OS

System install

Windows

C:\Program
Files\Cresset%LOCALAPPDATA%\Cresset-BMD\Spark\databases
BMD\Spark\databases
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Linux

/opt/cresset/Spark/databases /path/to/install/directory/cresset/Spark/databases

macOS

/Library/Application
Support/Cresset/Databases

Preference Setting

The ‘Databases’ tab of the Spark Preferences enables the addition of multiple
custom locations for databases.

Environment
Variable

The variable SPARK_CRESSET_DB is used as a path for databases. Setting this
variable enables to search for the Spark databases in multiple locations.

$HOME/Library/Application
Support/Cresset/Databases

If you require help or advice regarding your installation, then please contact Cresset support.

Supplied Databases
Cresset supply a range of fragment and reagent databases for use in Spark derived from commercially
available and literature compounds. The fragments obtained are split into separate databases based on the
frequency with which the fragments were observed.
Additional fragment databases derived from commercially available reagents and building blocks are
available through the database updater.
Details of the current databases can be found at http://cresset-group.com/current-spark-databases/.

Start Spark
Windows
The install process places an entry in the ‘Start menu’ and a shortcut on your desktop. Double click this
shortcut or navigate:
Windows 7
Start menu→Programs→Cresset→Spark
Windows 10
Choose Start, and type Spark (the search panel opens automatically as you type). In the search results, click
Spark to start the application.

Linux
If the installation was from rpm then select the shortcut in the Applications menu.
Alternatively, in a terminal window type:
/path_to_installation/cresset/Spark/bin/Spark
where path_to_installation is the directory where the Spark distribution was unpacked. If Spark was
installed from an rpm package with the default locations, then the installation will be in /opt.

macOS
Navigate to the Applications folder and double click the Spark icon.
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Licensing
To run Spark, you will require a valid licence file, available from enquiries@cresset-group.com. To install a
license, start the application and click on the ‘Install license’ button.

Changes in 10.5.6
•

Windows only release, to fix an issue causing an incorrect update of the 3D window. This issue only
affects systems with an Intel GPU and drivers version 24.* or later on the Windows operating system.

Changes in 10.5.5
•
•
•
•
•
•
•
•

Improved look & feel and performance of the 3D window graphics
Improved support for the configuration of proxy servers
Improved support for high-dpi displays
Improved Spark start up times when using databases sitting in a remote location on a slow connection
Fixed bug which caused the effect of the application of pharmacophore constraints to be overestimated
in some circumstances
Fixed bug on macOS which prevented to dock back in the desired position any dock window moved
outside of the main Spark interface
Fixed rare bug in the wizard where in some occasions the desired hydrogen atom could not be picked
for replacement
Functionality to show/hide the 3D border text now available from the View menu.

Changes in 10.5.0
•
•
•
•
•
•
•
•
•
•
•
•

New ‘Ligand Growing Experiment’ wizard, to grow a starter molecule into new space, guided by existing
ligands mapping a different region of the same active site
New ‘Join Two Ligands’ wizard, to join together with a linker two ligands sitting in the same active site
New ‘Macrocyclization’ wizard, to cyclize a molecule by joining two atoms with a linker
New ‘Water Replacement’ wizard, to search for a replacement group which will displace a
crystallographic water molecule near your ligand
New ‘Ligand Growing’ and ‘Ligand Joining / Macrocyclization’ calculation methods to support ligand
growing, ligand joining, macrocyclization and water replacement experiments
New functionality to download a starter molecule directly from the RCSB clicking the ‘Protein’ button in
the wizards
New functionality to replace Hydrogen atoms in the starter molecule
New ‘merge’ functionality to merge molecules in the wizards (when appropriate) and in the
Manage/Edit References dialog
New ‘Commercial’ databases derived from ZINC and eMolecules screening compounds
New sparkdbupdate.exe binary to update all or selected Spark databases
New ‘Install or Update Displayed Databases’ functionality in the Spark Database Updater, to install or
update all the Spark databases in one go
New ‘database category’ information now available in the Spark Database Updater, to organize the
databases to be updated in a logical structure
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•
•
•

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

New functionality in the Spark search dialog to inform the user that updated versions of the Spark
databases to be searched are available for download
New Constraint and Field Point Editor window, enabling users to:
Define pharmacophore constraints to bias Spark results to have a particular feature (for example, a Hbond acceptor) at a specific position, by introducing a penalty which down-scores results that do not
satisfy the constraint
Define field point constraints to specify that a particular type of field must be present in the Spark
results, by introducing a penalty which down-scores results that do not satisfy the constraint
Add customer-defined field points to be constrained
Enable protein display to help you set up pharmacophore and field constraints appropriately
New alternative similarity metrics (Tanimoto, Tversky) for scoring Spark results
New individual field similarity weighting for scoring Spark results
New ‘Send to Flare™’ functionality to send either all results, favorite results or selected results to Flare,
including as appropriate the starter and reference molecule(s) and the protein
New Storyboard window, to capture scenes recording all details from the 3D window that can be easily
recalled when needed, including capability to annotate and rename scenes
New button in Spark Appearance Preferences to swap color of fields (blue/red)
New functionality to control 3D display font and font size separately from the Spark application font
size
New stereo view functionality
New support for touch screen displays
New HiDPI support
New ‘Generate Diagnostic Data’ functionality available from the Help window to generate data which
can be used by Cresset support to troubleshoot problems
New Flexibility column in Spark Results tables
New Flexibility filter which can be applied to the whole molecule when performing a Spark search, to
limit the results to the desired physico-chemical space
Improved performance of Spark database generation
Improved Spark search algorithm now retaining multiple regioisomers for each Spark result (when
applicable)
Improved starter molecule region selector now including both 2D and 3D display
Improved ‘View Parent Structure for Selected Result’ functionality now including both substructure and
identity search
Improved File menu functionality, now also showing a list of recently opened molecules files in addition
to recently opened project files
Improved ‘Grid’ button functionality, replacing the old ‘Sep’ and ‘Grid’ buttons
Improved display of protein ribbons, offering a choice of different ribbon styles and capability to show
ribbons for the active site only
Improved export of CSV files, now including parent molecule SMILES
Improved handling of numerical filters
Text data stored in Spark project cells can now be copied into the clipboard
Improved look and feel of the GUI with re-designed toolbars and icons.
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Changes in 10.4.0
•
•
•

•
•
•
•

•

•

•
•
•

New Cresset reagent databases derived from eMolecule building blocks, replacing previous reagents
based on ZINC
Updated ChEMBL and ZINC fragment databases
New Results table columns:
o The TorsFreqFrag frequency is computed by analyzing all dihedrals associated with rotatable
bonds within the bioisosteric replacement (Schärfer et al. 2013, Guba et al. 2016). For each
such dihedral, the frequency of that torsion as recorded in the Cambridge Structural Database
(CSD) is assessed; the lowest frequency found across all analyzed dihedrals is reported as the
TorsFreqFrag frequency. ‘Low’ values are a possible cause for concern
o TorsFreq: For each new bond formed in the result molecule, the frequency of that torsion as
recorded in the Cambridge Structural Database (CSD) is reported. Torsions associated with a
low frequency are a possible cause for concern
o The Attachment Point Type columns record the atom type of the fragment atom which is being
attached to the starter molecule, facilitating the assessment of chemical feasibility. For
example ‘Nsp3’ in the ‘Attachment Point 1 Type’ column means that the fragment atom which
is joined to the first bond of the starter molecule is a sp3 hybridized nitrogen.
New external REST service for properties, enabling the connection to an external web service to import
external properties and data as additional project columns in the Results tables
User preferences can now be imported and exported using the corresponding buttons in the Edit →
Preferences menu
New export of MEP surfaces in the CCP4, Cube, Insight and MOE formats
Improved Radial Plots to support enhanced Multi-Parameter Optimization:
o A weight can be associated to each property in the Radial Plot to calculate a single numerical
score for each molecule which represents the overall fit of the compound to the ideal profile
o The score can be used to rank the molecules and colour molecules, columns, and radial plot by
score
Improved Spark Search dialog:
o More intuitive to use
o Provides information and warning notifications to support the correct set-up of the Spark
search
Improved Spark search options:
o Improved substructure filtering at calculation time now enables the specification of multiple
substructure(s) to be present or absent in the replacement fragments. The substructures can
be specified either using SMARTS patterns or by drawing a substructure in the Molecule Editor
o Improved behavior of ‘Automatic constraint of fragment size’ option to support fragment
growing experiments: if the portion of the starter molecule being replaced consists of one atom
only, no constraint will be applied
o New option to control hardness of protein excluded volume command line Spark (sparkcl)
Improved filtering on structure enables visualization of molecules that include or exclude a specific
substructure specified by a fragment drawn using a Molecule Editor
Any applied filters are now saved with the project
Double clicking on any result table cell will select the content of that cell, which you can then copy in
the clipboard by right-clicking and selecting ‘Copy’ from the context menu
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•
•
•

•
•
•
•
•

Rotating a torsion in the Molecule Editor will display a graph of the torsion energy
Project Notes promoted to separate window for recording experimental details
Improved visualization of protein active site:
o Protein active site radius control in Protein Display Toolbar
o Active site radius now saved with the project
o Separate display of H-bonds and steric clashes
o Measurements can be individually cleared
AccelrysDraw and ChemDraw structures can now be pasted directly into the Molecule Editor
Improved import/export of PDBs (PDB importer now correctly importing DNA/RNA)
Improved interface to CEBroker enables easy disabling
Improved tooltips
Fixed bug where 2D similarities using ECFP4 circular fingerprints were not calculated correctly.

Changes in 10.3.0
•

•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•
•

New tile view
o View results in a tiled layout to see multiple results at a glance
o Customize tiles to include
▪ radial plots
▪ the new tags
▪ selected other data
New tags feature enable the tagging of any result with a custom label
New filtering using SMARTS pattern of fragments at calculation time enables the specification of a
particular substructure to be present or absent in fragments
New post-result filtering on structure enables visualisation of results that include or exclude a specific
SMARTS pattern
Updated databases
New reagent patterns and databases for aromatic alcohols and nitriles
New protein importer for loading proteins from PDB files
Improved wizard with cleaner looks and smoother workflow
New option to control the minimization of newly formed molecules
New options for sdf file processing that enables multiple sdf tags to be recorded for any parent
fragment and reported in the final results table
New option to control the minimization of conformations of fragments committed to the database
New button to limit display of protein atoms to those close to the ligands
Introduced integration with Cresset’s Engine Broker to enable calculations to be performed on a Linux
cluster from Windows, Mac and Linux clients
New preferences to enable control of information that is shown in the results tables and tile views
New option to use a protein excluded volume for visualization but to ignore it in the calculations
New ‘Notes’ column enables the collection of thoughts about specific results
Improved database download tool - faster operation and clearer GUI
Improved default location for the creation of databases on windows
Improved Windows installation location to fit with Microsoft policies
Improved Protein display options to include ribbons
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•
•
•

Improved substructure search for fragments on generic websites
Unified the last used directories into a single entry - now ‘Save as’ starts in the last directory used for
any task not the last directory used for saving projects
Improved help text for the command line binaries

Changes in 10.2.0
•

•
•
•
•
•
•
•
•
•
•
•
•

•
•
•

•
•
•

New radial plot feature to visually represent multiple result column properties
o Radial plot for every result molecule in the result table
o Separate radial plot window to visualize plots for many results
o Plot optimal values at the center or edge of the radial plot
o Customize plots to give exactly the properties required for the current target
New preference panel to configure how standard properties are plotted in the radial plot
New ‘Field difference’ display that highlights the change in the field surface potentials of the current
molecule with respect to the starter molecule
New fullscreen mode for the 3D window
New rock and spin options for the 3D window
New option to limit the display of the protein to just those surrounding the reference molecules
New ‘Send to’ menu to transfer results to Forge or Torch
Improved visual display of cluster for scaffold cluster method
New ‘attachment type’ information that reports the types of atoms that have been connected to the
fragment that was used in the result
New clearer database selection widget in experiment setup
New fragment parent lookup window providing live choice of lookup location without the need to
change a preference setting
New database generation method that imports conformations enabling the creation of databases from
crystal structure information
New database generation method that converts reagents into searchable databases
o 17 Methods for conversion of reagents into R groups supplied that cover most reactive species
including the processing of amines, carboxylic acids, boronates, isocyanates, and alkyl halides.
o Easy to customize architecture - add your own transformation or ask us to do it for you
o Rapidly create databases based on the reagents on your shelf
New hierarchy for databases using ‘Category’ and ‘Sub-category’ to partition databases in the search
pane
New preference to invert the mouse zoom on the 3D window
Improved database preferences
o Added ability to add custom search locations for databases to use in searching
o Added customisable location for database download using the built-in database updater
New choice of 2D similarity (Merck Atom Pairs or Circular Fingerprints or Circular Pharmacophore
Fingerprints) to use in the results window
New preference to set custom StarDrop model locations
New databases
o Significant reduction in file size while maintaining quality
o Increase in the total number of fragments
o Updated for ChEMBL release 17
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•
•
•
•
•
•
•
•

o New reagent databases from processing of reactive species. 17 separate databases supplied
Improved the database creation algorithm to minimize time spent committing fragments and improve
throughput when running with >100 FieldEngines
Improved the ‘Show interactions with protein’ algorithm to give better results
Improved charging of final molecules when fragment or new bond creates a conjugation to a charged
moiety
Fixed bug where physical property data was not exported properly
Fixed bug where the option to delete an entire cluster of results did not work properly
Improved documentation for command line Spark
Removed ‘Quick’ settings that gave poor quality results and were not much faster than ‘Normal’
Numerous minor improvements or bug fixes

Changes in 10.0.1
•
•

Fixed bug where licensing would erroneously fail after detecting a third party license file
Updated ChEMBL derived databases (now based on ChEMBL 15)

Version 10.0.0
•

Initial release of Spark derived from earlier FieldStere application.

Uninstalling Spark
Windows
Spark can be uninstalled using the standard ‘Programs’ Control Panel shortcut. Databases can be manually
deleted from their install location (usually %APPDATA%\Cresset-BMD\Spark\databases or C:\Program
Files\Cresset-BMD\Spark\databases).

Linux
If Spark was installed from a rpm package, it can be uninstalled with one of the following command lines,
depending on whether it was installed with the rpm or yum command:
rpm -e cresset-spark-<vers>-1.<arch>
or
yum erase cresset-spark-<vers>-1.<arch>
If Spark was installed by unpacking a tgz file, it will be sufficient to remove the containing folder from the
disk.
Databases can be manually deleted from their install location (usually the $HOME/spark_db directory).

macOS
In the Finder sidebar, click Applications. Drag the Spark from the Applications folder to the Trash (located at
the end of the Dock).
Databases can be manually deleted from their install location (usually $HOME/Library/Application
Support/Cresset/Databases).
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Known Issues and Bugs
Spark will crash when the File dialog is opened if "Dell Backup and Recovery Application" between versions
1.7.5.64 and 1.9.2.8 ( list not inclusive) is used on your computer.
In rare circumstances Spark will crash using invalid SMARTS with the SMARTS filter.
Scaling of GUI elements may be sub-optimal with high resolution monitors connected through legacy VGA
cables.
When using multiple monitors with differing text scaling settings the toolbars and other GUI elements can
display poorly requiring the layout of the GUI to be reset using Windows menu → Reset Layout.
Occasionally Spark is able to find similarities greater than 1 or less than 0. These occur with small molecules
using constraints with a high fraction of shape based scoring.

macOS
On some versions of macOS the selection of atoms in the 3D window does not work correctly making
measurement of distances difficult.
In some circumstances, after using the fullscreen function the application reports a crash instead of exiting
cleanly. The report is not harmful as it only happens as the application closes and no data is lost.
In the manage columns in results table widget, selecting and dragging many elements between the displayed
and un-displayed sections causes the application to crash.
Found a bug or problem that is not listed? Please contact us and help improve our software!

Support
Cresset
New Cambridge House
Bassingbourn Road
Litlington
Cambridgeshire, SG8 0SS, UK

February 8, 2019

+44 (0)1223 858890
support@cresset-group.com
www.cresset-group.com
Twitter: @cressetgroup
LinkedIn: Cresset group
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